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Introduction to Search Techniques 

State and local district staff record the results of much of their work with children and families in 
CONNECTIONS. For this reason, CONNECTIONS is the first place in which a caseworker 
would identify historical information about individuals involved in a CPS investigation. 

In these modules, you will learn how to use CONNECTIONS to find information about people 
associated with a stage you have been assigned. You will also learn how to find out more about 
historical cases with which the family members may have been involved. To help you meet a 
client’s needs, CONNECTIONS helps you locate staff statewide and find information about 
professional community resources that are available. 

This guide, will help you do the following: 

• Find out if a person is known to CONNECTIONS and access detailed information 
about a person. 

• Locate information about a case. 

• Obtain information about providers of child welfare services in New York State. 

• Locate information about agencies, offices and units to access information regarding 
CONNECTIONS users. 

As a Child Protective Services caseworker, you have taken on a vital role in the New York State 
Office of Children and Family Service’s mission to ensure safety and permanence for children. 
Child welfare practice in New York State strives to achieve the following five outcomes for 
children and families: 

• Children are safe. 
• Families are preserved. 
• Children are adopted when their birth family cannot be preserved. 
• Children leaving care at the age of majority can live independently. 
• Children and youth in care develop normally. 

Caseworkers use CONNECTIONS, New York’s Statewide Automated Child Welfare 
Information System (SACWIS), to search and review historical records, update data and 
document the steps taken throughout the casework process. This guide leads you through the 
searches you will use in CONNECTIONS. Each type of search, and the data it retrieves, is 
explained in detail. You can then determine which type of search will generate the most effective 
results for the search criteria you enter, which supports your ability to achieve these outcomes. 
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The Content of this Guide 
This guide is divided into four modules that explain the CONNECTIONS navigation skills for 
each type of search. It also contains hands-on practice exercises for you to use with the Training 
Database to reinforce your CONNECTIONS skills. These exercises cover the searches—Person, 
Case, Resource, Staff and Office—that are essential to the activities you perform in 
CONNECTIONS as a caseworker. 

Features of this Guide 
This guide contains a number of tips, set apart in margin boxes, on how to conduct 
CONNECTIONS searches effectively. Icons in the boxes help focus your attention on three 
kinds of tips: 

Bright ideas 

Helpful hints 

Things to watch out for 
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Using the Training Database with this Guide 
You can use this guide in two ways: as a training tool to develop new skills and as a job aid for 
your work in CONNECTIONS. In either case, we suggest that you use this guide while working 
directly in CONNECTIONS Production or in the Training Database. 

What is the Training Database? 
The Training Database provides a safe environment for workers to learn and practice 
CONNECTIONS skills using simulated case data. The SUNY Training Strategies Group acts as 
the custodian for the Training Database sign-on IDs. These ID numbers are referred to as 
Desktop User (DU) numbers and Instructor Led (IL) numbers. Sign-on numbers begin with 
either DU or IL, and are followed by four digits. With a DU number a local district or voluntary 
agency staff member can sign on to the Training Database and practice using CONNECTIONS 
functionality that mirrors the CONNECTIONS Production system. 

The Training Database has the look and feel of the CONNECTIONS system currently in 
production. When you sign on to the Training Database using a DU number, you will see a 
simulated environment displaying the Assigned Workload of a fictitious worker, Darryl Wilson. 
Darryl Wilson has been assigned seven stages of service, including five Child Protective Service 
(CPS) stages. These stages have been created specifically for training purposes. In the New York 
City training labs, you will use IL numbers, which display the Assigned Workload for a fictitious 
worker named Jamie Miller. 

When you sign on as Darryl Wilson or Jamie Miller, you have the ability to complete the tasks 
necessary to maintain and progress each stage of service. As a CPS caseworker, you have the 
ability to accept or reject an Intake stage of service, progress the Intake to the Investigation 
stage, and perform all tasks necessary to complete an Investigation. The Training Database also 
has common functions, such as Person Search, Resource Search, and a Staff To-Do List. 

Darryl Wilson also has the ability to access the workload of his supervisor, Sally May. Jamie 
Miller has the ability to access the workload of his supervisor, Cassie Landers. You may approve 
work submitted by Darryl Wilson by opening Sally May’s Staff To-Do List and completing 
related approval tasks. Opening Cassie Landers’ Staff To-Do List and completing the related 
approval tasks approves the work submitted by Jamie Miller. 

Information is deleted when the computer system is refreshed each night; any material that you 
enter into the system is available to you only until the end of that day. 
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Lending Procedures for Training Database DU Numbers 
SUNY Training Strategies Group is responsible for lending DU numbers to voluntary agencies 
and local districts. Agencies and districts can use these DU numbers to train new workers and to 
allow experienced workers to practice new skills. 

The procedure for obtaining DU numbers is outlined below: 

• Local districts and voluntary agencies are encouraged to identify one person from each 
agency who is designated to have the authority to request DU numbers. 

• The designated person should call 1-877-451-4835 and ask to borrow DU number(s) for 
a specific period of time. 

• DU numbers can be borrowed for up to three weeks at a time; a maximum of four DU 
numbers may be borrowed per order. 

• The following information is needed at the time of the request: 

◊ Borrower’s name 
◊ Borrower’s agency/facility 
◊ Telephone number 
◊ Start date for use of DU number(s) 
◊ Expiration date 
◊ Purpose of the request 

 
• The caller will be provided by e-mail with the requested number of DUs and a password 

for each DU number assigned. 

• Once you have received DU numbers, follow the directions below to access the 
CONNECTIONS Training Database. 
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Logging On to Your PC 
The CONNECTIONS application can be accessed only by designated individuals on computers 
that are set up to run the application. Some CONNECTIONS computers use the Windows NT 
3.51 operating system, while newer CONNECTIONS computers use Windows 2000. This 
section addresses the procedures for logging on to both of these operating systems. 

Once you have completed logging on to Windows, the step-by-step instructions in the next 
section will show you how to access CONNECTIONS. 

 

Step-by-Step: 
Logging On to the Windows NT 3.51 Operating System 

1 Press the Ctrl + Alt + Delete keys on your keyboard at the same time. 
A Confidentiality warning displays. 

2 Click on the OK button in response to the Confidentiality warning. 
The Log On window displays. 

3 Enter your user name in the Username field. 

4 The From field (“domain”) is pre-filled. To change the domain, click on the drop-
down arrow and select from the resulting list. 

5 Tab to the Password field and enter your password. 
This field is case sensitive. 

6 Click on the OK button. 
The Program Manager window displays for your local desktop. 
 

 

Step-by-Step: 
Logging On to the Windows 2000 Operating System 

1 Press the Ctrl + Alt + Delete keys on your keyboard at the same time. 
A Confidentiality warning displays. 

2 Click on the OK button in response to the Confidentiality warning. 
The Log On window displays. Make sure that your user name and domain are listed 
correctly in the log on dialog box.  

3 Enter your password and click on the OK button. 
Your Windows 2000 local desktop displays. 

Accessing CONNECTIONS 
The CONNECTIONS application is made available to users in three different ways: 
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• Production Database The Production Database contains “live” data. This is the 
database that all workers use to record information in 
CONNECTIONS. 

• Training Database The Training Database contains simulated data and allows you to 
practice functions necessary for your casework activities. It 
mirrors the functionality of the Production Database. 
(See “What is the Training Database?” on page 3 and “Lending 
Procedures for the Training Database DU Numbers” on page 4 
for more information.) 

• Preview Application The Preview Application contains a “snapshot” of actual case 
data. Information entered into the Preview application does not 
carry over to the Production database. 

The Preview Application provides the opportunity to preview 
changes and enhancements planned for the CONNECTIONS 
system. The Preview Application is available for a limited time 
when changes to the system are made. You will receive special 
notice when the Preview application becomes available. 

You cannot have more than one of these applications open at 
the same time. 

To distinguish between the Training Database and the Preview 
application, keep in mind that the Training Database contains 
simulated data, while the Preview application is a “snapshot” of 
actual case data. The Training Database allows you to practice 
functions necessary for your casework activities. Information 
entered into the Preview application does not carry over to the 
Production database. 

Using the CONNECTIONS Production Database, you can access your Assigned Workload from 
any CONNECTIONS workstation throughout New York State. All you need is a valid User ID 
and password to gain access to your workload. 

 

Information about accessing 
CONNECTIONS is also 
included in Appendix A. 
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Step-by-Step: 
Launching CONNECTIONS (Production) 

 

1 Double-click the CONNECTIONS Logon icon 
in the Windows Program Manager. 
The CONNECTIONS Logon Program Group 
displays. 
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2 Double-click the Logon for CONNECTIONS 
Production icon 
A Microsoft Internet Explorer window displays 
containing the Logon dialog box for Citrix. 

 

3 Enter your User Name in the Username field. 
This field is pre-filled with information entered by 
the last person who used this computer.\ 

4 Enter your password in the Password field. 
This field is case sensitive. 

5 Enter the appropriate domain in the Domain field. 
This field is pre-filled with information entered by 
the last person who used this computer. 

6 Click on the Logon button. 
A File Download Progress box displays, followed by 
a Confidentiality Warning message box. 

7 Click on the OK button. 
The Citrix desktop displays and your Citrix session begins. 

This Citrix desktop covers your local desktop and remains open 
for the length of your Citrix session. Citrix uses Windows 2000; 
if your PC runs Windows NT 3.51, the Citrix desktop looks 
quite different from your local desktop. The Citrix desktop also 
has an easily recognizable background. 

On the Citrix desktop, program icons appear directly on the 
desktop, rather than in Program Group windows (as on your 
local desktop, if your computer runs Windows NT 3.51). 
Double-clicking an icon starts the application represented by 
that icon, opening a window on your desktop for that 
application. 

The Task Bar at the bottom of the Citrix desktop provides a method of organizing the 
application windows that you have open in Citrix. You can have more than one window open on 
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1 Double-click the 
Logon to 
Connections 
Production icon. 
A Microsoft Internet 
Explorer window 
displays containing 
the Logon dialog box 
for Citrix. 

 
If you incorrectly enter your 

password, the following 
message displays:  

“There was an error generating 
your application list: the Citrix 

Server reported that the 
Credentials entered were 

incorrect.” 

Re-enter your password and 
click on the Logon button. 

 
Windows NT 3.51 PCs display 
scroll bars on the bottom and 
right side of the screen; these 
scroll bars allow you to access 

the small portions of the 
desktop not visible when the 

Citrix desktop first opens. 
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your desktop at a time. Minimize a window by clicking on the Minimize button ( ). The 
minimized window displays as a button on the Task Bar. This makes room for other windows 
you need to use at that moment. To re-open an application, click on its button on the Task Bar; 
the application displays as the active window, placing it “on top of” any other open windows. 

Clicking on the Start button (in the lower left corner of the Citrix desktop) displays the Start 
menu, which provides access to the Citrix Log Off procedure (see page 11 for details on this 
procedure). 

Within Citrix, the Windows 2000 system consisting of desktop icons, the Start menu and the 
Task Bar, replaces the Program Manager and Program Group system of program management 
found on CONNECTIONS PCs using Windows NT 3.51. 

When you log on to Citrix via the CONNECTIONS Production Database icon on the local 
desktop, three icons display on the Citrix desktop: 

• CONNECTIONS Production 
• CIN/PID (Data Warehouse; limited to designated users) 
• Policy Library 

 
Double-clicking either of these icons opens the corresponding application. 

 

Step-by-Step: 
Launching CONNECTIONS (Training Database) 
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s 1 Double-click the CONNECTIONS Logon 

icon in the Windows Program Manager. 
The CONNECTIONS Logon Program Group 
displays. 

2 Double-click the Logon for CONNECTIONS 
Training/Preview icon 
A Microsoft Internet Explorer window displays 
containing the Logon dialog box for Citrix. 

3 Enter a training user name (DU or IL#) in the 
Username field. 
This field is pre-filled with information entered by the last person who used this 
computer. 

4 Enter the same training user name (DU or IL#) in ALL CAPS in the Password field. 
This field is case sensitive. 
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1 Double-click the 
Logon to 
Connections 
Training/Preview 
icon. 
The Citrix Logon 
dialog box displays 
in Microsoft 
Internet Explorer.  
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5 Enter the appropriate domain in the Domain field. 
This field is pre-filled with information entered by 
the last person who used this computer. If you are 
unable to logon using the NYSDSSNYC domain, 
enter NYSDSSALB in the Domain field. 

6 Click on the Logon button. 
A File Download Progress box displays, followed by 
a Confidentiality Warning message box. 

7 Click on the OK button in response to the 
confidentiality warning message. 
The Citrix desktop displays and your Citrix session 
begins. (For detailed information about Citrix, see 
page 7.) When you sign on using the Logon for 
CONNECTIONS Training/Preview icon, three 
icons display on the Citrix desktop: 

• CONNECTIONS Training 
• CONNECTIONS Preview 
• Policy Library 

8 Double-click the CONNECTIONS Training icon on the Citrix desktop. 
When the CONNECTIONS Training Database has launched successfully, the 
CONNECTIONS Toolbar displays. In the title bar, the DU number you entered 
displays as the fictional caseworker Darryl Wilson with the same ending digits, not 
counting zeroes (e.g., DU0123 displays as Wilson123,Darryl). If you entered an IL 
number, the title bar displays the name of the fictional caseworker Jamie Miller with 
the same ending digits, not counting zeroes. 
 

 

Step-by-Step: 
Launching CONNECTIONS (Preview Application) 

 

 
If you incorrectly enter your 

password, the following 
message displays:  

“There was an error 
generating your application 

list: the Citrix Server reported 
that the Credentials entered 

were incorrect.” 

Re-enter your password and 
click on the Logon button. 
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1 Double-click the 
Logon to 
Connections 
Training/Preview 
icon. 
The Citrix Logon 
dialog box displays 
in Microsoft 
Internet Explorer. 
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s 1 Double-click the CONNECTIONS Logon 

icon in the Windows Program Manager. 
The CONNECTIONS Logon Program Group 
displays. 

2 Double-click the Logon for CONNECTIONS 
Training/Preview icon 
A Microsoft Internet Explorer window displays 
containing the Logon dialog box for Citrix. 
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3 Enter your user name in the Username field. 
This field is pre-filled with information entered by 
the last person who used this computer. 

4 Enter your password in the Password field. 
This field is case sensitive. 

5 Enter NYSDSSNYC in the Domain field. 
This field is pre-filled with information entered by 
the last person who used this computer. If you are 
unable to logon using this domain, enter 
NYSDSSALB in the Domain field. 

6 Click on the Logon button. 
A File Download Progress box displays, followed by 
a Confidentiality Warning message box. 

7 Click on the OK button in response to the confidentiality warning message. 
The Citrix desktop displays and your Citrix session begins. (For detailed information 
about Citrix, see page 7.) When you sign on using the Logon for CONNECTIONS 
Training/Preview icon, three icons display on the Citrix desktop: 

• CONNECTIONS Training 
• CONNECTIONS Preview 
• Policy Library 

8 Double-click the CONNECTIONS Preview icon on the Citrix desktop. 
When the CONNECTIONS Preview Application has launched successfully, the 
CONNECTIONS Toolbar displays. The title bar reads, “CONNECTIONS Preview - 
<Your Name>. 

 

 
If you incorrectly enter your 

password, the following 
message displays:  

“There was an error 
generating your application 

list: the Citrix Server reported 
that the Credentials entered 

were incorrect.” 

Re-enter your password and 
click on the Logon button. 
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Closing CONNECTIONS and Logging Off Your PC 
When you have finished your work in CONNECTIONS, you should close both 
CONNECTIONS and your Citrix session. This is best done as a two-step process: first close 
CONNECTIONS, then log off of Citrix. Doing so (as opposed to logging off of Citrix while 
CONNECTIONS is still open) reduces the likelihood of problems occurring during the log off 
procedure. 

At the end of your work day, it is important to log off your PC; if you completely shut down 
(turn off) your computer, it will not be able to receive any updates that may occur overnight. 
Leaving the computer logged off (but with the power still on) will enable it to receive these 
updates. 

The step-by-step instructions below will assist you in closing CONNECTIONS and logging off 
of your PC. 

 
 

 

Step-by-Step: 
Closing CONNECTIONS and Logging Off Your PC 

1 Clicking on the File menu (represented by the Globe icon [ ] in the upper left 
corner of the CONNECTIONS Toolbar) and select Close. 
—OR— 
Click on the Close button ( ) in the upper right corner of the CONNECTIONS 
Toolbar. 
You may need to use the vertical scroll bar to scroll up on the desktop to reveal the 
Globe icon (File menu) on the CONNECTIONS Toolbar. 

2 Click on the Start button in the lower left corner of the Citrix desktop and select Log 
Off <User name> from the resulting menu. 
The Log Off dialog box displays. 

3 Click on the Yes button. 
This does not log off your machine; it only ends your session with the Citrix server. 
Your local desktop displays. 

4 Close all applications still open on your local desktop. 
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5 Click on the File menu and 
select Shutdown. 
The Shutdown Computer dialog 
box displays. 

6 Click on Log off <user name>. 

7 Click on the OK button. 
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5 Click on the Start button. 
The Start menu displays. 

6 Click on the Log off <user 
name> command. 
The Shutdown Windows dialog 
box displays. If necessary, click 
on the drop-down arrow and 
select Log off <user name>. 

7 Click on the OK button. 

 
If the AutoComplete window displays during the logon process, 

select the Don’t offer to remember any more passwords 
check box and click on the No button. 



 

CONNECTIONS Step-by-Step Guide: Page 13 
Search Techniques for CPS Caseworkers (rev 11/18/2003) 

CONNECTIONS Security and Search Functionality 
All CONNECTIONS users receive security profiles which determine the windows or types of 
information they can open and view, as well as which windows they can modify or “maintain.” 
In CONNECTIONS, each person’s security profile is called a Business Function Profile (BFP). 
Each worker has only one BFP. Each BFP is comprised of one or more Business Functions, 
which in turn are comprised of one or more Security Attributes (see the graphic below). Business 
Function Profiles are based on the tasks that workers perform and the level of access to records 
needed to complete those tasks. A CONNECTIONS user’s BFP may be have multiple business 
functions based on the worker’s responsibilities. Business Function Profiles are designed to 
protect the confidentiality of client records in CONNECTIONS. 

 

The table below indicates some CONNECTIONS Business Functions and their corresponding 
security attributes. 

Business Function Security Attribute(s) 
Supervision Maintain Designees 

Unit Summary Access 

Sensitive Case View Sensitive Case 

Maintain Security Maintain Security 
Maintain Login 
View Business Functions 

 

Business Function Profiles are developed by OCFS. Security coordinators at the local district 
and voluntary agency level assign specific BFPs to staff in their offices. A few examples of 
Business Functions that might be included in a local district CPS caseworker’s BFP are “View 

Business Function ProfileBusiness Function Profile

Business 
Function

Business 
Function

Security 
Attribute

Security 
Attribute

Security 
Attribute

Security 
Attribute

Business 
Function

Security 
Attribute

Business Function ProfileBusiness Function ProfileBusiness Function ProfileBusiness Function Profile

Business 
Function
Business 
Function

Business 
Function
Business 
Function

Security 
Attribute
Security 
Attribute

Security 
Attribute
Security 
Attribute

Security 
Attribute
Security 
Attribute

Security 
Attribute
Security 
Attribute

Business 
Function
Business 
Function

Security 
Attribute
Security 
Attribute
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Under Investigation,” “View Indicated” and “View 
Unfounded.” Supervisors’ BFPs allow them to review their staff 
members’ Assigned Workloads. 

As you use CONNECTIONS, you may see buttons and menus 
which are gray instead of black. The gray color indicates that 
this function is disabled and, therefore, not available to you. 

Features are sometimes disabled based on your BFP. For 
example, the UNIT button on the CONNECTIONS Toolbar is 
disabled for caseworkers, since this function is available only to 
supervisors. If you there is information on the system that you 
need to access in order to complete your work, but that 
information is not available to you, talk to your supervisor. 

If you are working on a stage and cannot view or modify information that relates to your job 
responsibilities, you should review your security profile with your supervisor to make sure the 
Business Functions included in your BFP are adequate for the work you are doing. A special 
Business Function, “View Security Profile,” allows you to review your BFP in CONNECTIONS 
to see the business functions assigned to you. If your BFP indicates that you do not have security 
access for a task you need to complete, speak with your supervisor and your office’s security 
coordinator. 
 

 

Step-by-Step: 
Viewing Your Security Profile 

1 Click on the Options menu on the CONNECTIONS Toolbar and select Security. 
The Security “fly-out” menu displays. 

2 Click on the View Staff Security command. 
The Staff Search Criteria window displays. 

3 Type your first and last names into the appropriate fields. 

4 Click on the Search button. 
The Staff List displays. 

5 Click on your name to select it. 

6 Click on the OK button. 
The Staff Security window displays. Within the window is a Business Function list box 
containing business functions that have been assigned to you. 

7 Use the vertical scroll bar inside the Business Function list box to view your security 
profile. The BFPs assigned to you are identified with red check marks. 

 

What you are able to view and 
the tasks you are able to 
perform in the Training 

Database may not mirror what 
you will be able to do in the 

Production Database. Contact 
your security coordinator if you 
have questions regarding your 

security access. 



 

CONNECTIONS Step-by-Step Guide: Page 15 
Search Techniques for CPS Caseworkers (rev 11/18/2003) 

8 To close the Staff Security window, click on the Cancel button. 
The Staff List displays. 

9 To close the Staff List, click on the Close button. 
The Staff Search Criteria window displays. 

10 To close the Staff Search Criteria window, click on the Close button. 
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Module 1: 
Person Search 

The CONNECTIONS database includes information on individuals associated with child 
protective cases, as well as foster care providers, state and local district staff, and voluntary 
agency personnel. As a CPS caseworker, you may need to locate information regarding some of 
these individuals. Person Search is a tool for locating information about people in 
CONNECTIONS.  

Person Searches are used to: 

• find out if a person is known to CONNECTIONS; and 
• find specific information on a person in CONNECTIONS. 

 
Persons are not identified as sources or reporters in a Person Search, even if they are listed 
as members of the household. If a reporter is also a principal, Person Search will return the 
principal information only. For example, if a mother is the source of a report of child abuse or 
maltreatment regarding her own child and the child’s father, she is both the reporter and a 
principal in the case. A Person Search on the mother will only return information identifying her 
as a principal, not as a reporter. 

In the course of your work, you may find that a family member 
is not listed on the Person List for a stage. You are required to 
add that individual to the stage. Maintaining an accurate record 
of the family composition is beneficial to you and to any future 
caseworkers. A complete record in CONNECTIONS is 
necessary when documenting and generating required 
notifications. Future caseworkers are also provided with an 
accurate picture of the family composition at the time of your 
investigation.  

Prior to adding an individual to a stage, you are required  
to conduct a Person Search to determine whether that individual 
is already known to the CONNECTIONS database. 

Once a search is performed, the Case List button on the Person Search window provides access 
to the selected person’s case information. Any historical information found on individuals in 
your case could be helpful to your current investigation. This information can also be accessed 
from the Options menu. 

CONNECTIONS automatically walks you through a Person Search when you add an individual 
to a stage. This is a precaution to make sure duplicate records are not created. 

 

The only information available in 
a Person Search regarding 

employees is their name and 
Person ID number. 

More information can be 
obtained on employees by 
conducting a Staff Search. 

Staff Searches are covered in 
Module 4 of this guide.  
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Routes to the Person Search Window 
All Person Searches are conducted from the Person Search window. There are two routes to the 
Person Search window: 

• From the CONNECTIONS Toolbar 
• From the Maintain Person task within a stage 

As a CPS caseworker, you most often conduct a Person Search through your Assigned Workload, 
using the Maintain Person task within a stage. This enables you to maintain information (e.g., 
add or relate a person) for that stage. As the assigned worker, your role in the case determines 
your access and your ability to maintain data. 

On occasion, you may need to search for an individual from the CONNECTIONS Toolbar. This 
is beneficial when you are not the assigned worker, but need information on a person or case. 

 

Step-by-Step: 
Opening the Person Search Window from the CONNECTIONS Toolbar 

1 Click on the PERS button on the CONNECTIONS Toolbar. 
The Person Search window displays. 
 

 

Step-by-Step: 
Opening the Person Search Window Within a Stage 

1 Click on the WORK button on the 
CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Click on a stage to select it. 
The Tasks… button enables. 

3 Click on the Tasks… button. 
The Task List displays for the selected stage. 

4 Click on the Maintain Person task. 

5 Click on either the New or List… button. 
The Person List displays. 

6 Click on the New button. 
The Person Search window displays. 

 

The Maintain Person task 
is available only for  

Investigation (INV) and 
Foster/Adoptive Home 

Development (FAD) stages. 
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Person Search Methods 
 
The Search Type drop-down list in the Person Search window contains two person search 
options that indicate the type of search in effect: 

• Phonetic Name 
• Phonetic Address 
• Exact 

 

Phonetic Name Search 
Person Search defaults to the Phonetic Name search type. Phonetic Name search returns 
matches that sound similar to the search criteria, which usually produces the largest pool of 
results. You can use Phonetic Name search even if the name you are searching for is not 
spelled correctly. The Last name field is required to enable a Phonetic Name search. 

For step-by-step instructions, see “Conducting a Phonetic Name Search from the Toolbar” on 
page 24, and “Conducting a Phonetic Name Search Within a Stage” on page 28. 

 

Phonetic Address Search 
Phonetic Address Search returns results that sound similar to the information entered in the 
Address section. The Street 1 field is required to enable a Phonetic Address search. When 
the Phonetic Address search type is selected, all non-address fields disable. All address fields 
are enabled, but search criteria must be entered in the Street 1 field to initiate a Phonetic 
Address Search. 

For step-by-step instructions, see “Conducting Address Searches” on page 30. 

 

Exact Search 
An Exact search returns results that match the search criteria character for character and 
space for space. You can use Exact search when you know the exact spelling of the person’s 
name for whom you are searching. This is also useful if you want to narrow the search 
results. 

• Last Name   
• Street 1   
• Social Security Number (SSN)   
• Client Identifier Number (CIN)   “Identifiers” 

Required fields for an Exact 
Search are: 

• Person ID  
Only one of these five fields needs to have data entered to execute the search. Once 
information is entered into one Identifier field (SSN, CIN or ID), the remaining Identifier 
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fields disable. Likewise, once a non-Identifier criterion is entered, all of the Identifier fields 
disable. 

You can also filter Exact search results by using other search 
criteria; this helps you retrieve the best possible results for 
your search. When you use filters, the criteria you enter 
(other than one of the required criteria) acts as a filter to the 
selection criteria’s original pool. 

If you enter address criteria, validate the address criteria 
using CODE-1 before executing the search to increase the 
likelihood of receiving address matches, since most 
addresses in the system are CODE-1 validated when they are 
recorded. 

For step-by step instructions, see “Conducting an Exact 
Search from the Toolbar” on page 27 of this guide. 

 

Searching by Name: 
Phonetic Name Search vs. Exact Search 
When searching for a person by name, you can conduct either a Phonetic Name search or an 
Exact search. The system defaults to a Phonetic Name search, which returns records with names 
that sound similar to the search criteria. For example, if you conduct a Phonetic Name search for 
“Stewart,” CONNECTIONS may also return “Stuart” in the results. Phonetic Name search also 
returns common equivalencies for names (e.g., searching for “James” also returns matches for 
“Jim” and “Jimmy”). 

You can also use the Phonetic Name search type to search for all forms of hyphenated last names 
in a single search. Results for all potential hyphenated name combinations are important, since 
the person you are searching for may have had only one of the two names originally recorded in 
the system, or the hyphenated last name may originally have been recorded in the opposite order 
from the way the current search is entered. 

This feature applies to the Last name field only, not for first or middle names. In order to use 
this feature effectively, you need to add a hyphen between the two names listed in the Last Name 
search field. Without the hyphen, the system only searches on the two last names as a multiple 
last name in the order in which they appear in the search field. 

For examples of Phonetic Name search results on hyphenated last names, see the table at the top 
of the next page. 

 

 
Required fields on the Person 

Search window appear in yellow 
when the search type is 

selected. Fields that are not 
available for a given search type 
disable when that search type is 
selected. If you want to search 
again using other criteria, click 
on the Clear button to clear the 

fields prior to conducting the 
new search. 
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A Phonetic Name search on these 
criteria: 

First Name Last Name 

Produces a single candidate pool 
consisting of the following names: 

Mary Smith-Jones 
Mary Smith-Jones 
Mary Jones-Smith 

Mary Smith 
Mary Jones 

Mary Smith Jones 
(no hyphen) Mary Smith Jones 

 

The scoring of every name in the candidate pool is always based on the specific search name 
entered by the user. Although names phonetically further away from the search name will score 
lower, users conducting online Intake or Toolbar searches will ultimately be able to see all 
possible matches. 

When searching on a common name, you may want to try an Exact search. An Exact search 
returns matches that are identical to the search criteria. Use the vertical scroll bar and “mega-
scroll” buttons to view all of the results. 

All Person Searches display a message on the Person Search List title bar. These messages 
provide a short description of the results. The message which displays depends on the type of 
search you conduct. 

A Phonetic Name search displays the following messages: 

• Phonetic Name Results Returned: All records in the database that sound like the 
search criteria are returned in the Person Search List. 

• No Results Returned: No records in the database match the search criteria. 
 

An Exact search displays the following messages: 

• Exact Results Returned: All records in the database that exactly match the search 
criteria are returned in the Person Search List. 

• No Results Returned: No records in the database match the search criteria. 
 

Deciding whether to use Exact search or Phonetic Name search depends on the available search 
criteria. Here are some general rules of thumb to start your search: 

• When you are not sure of the proper spelling of the name of the person for whom you 
are searching, begin with a Phonetic Name search. 

• If you are certain of the exact spelling of the name you are searching for, conduct an 
Exact search. Be aware that if the person’s name was previously entered incorrectly, 
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an Exact search will not return the misspelled name. Exact searches do not always 
return the best results. 

• When conducting a Phonetic Name search on a common name, it’s a good idea to 
enter as much information as possible about the person you are searching for, in order 
to narrow the search criteria. 

• Selecting “M” (male) or “F” (female) in the Sex field ranks your search results, with 
records matching the selected criterion in the Sex field returning higher in the Person 
Search List, followed by records with other values in the Sex field.  

• Phonetic Name search returns “flip-flops” (also know as Reverse Name Matches)—
that is, results that reverse the first and last names (e.g., searching on “John Williams” 
returns matches such as “William Johnson”). These results appear at the bottom of 
the list in a Phonetic Name search. Flip-flop matches do not return in an Exact search. 

• Entering an age and/or date of birth (DOB) also affects your search results. Results 
are listed by score. The results at the top of the Person Search List are the closest 
match to the name and age/DOB you entered. CONNECTIONS considers adults’ 
ages a bit differently than children’s ages: 

⇒ If you enter an age/DOB representing an age of 18 or older, the system returns 
matches within a ten-year range (+/- 5 years of the age/DOB entered) toward the 
top of the Person Search List. 

⇒ If you enter an age/DOB representing an age under 18, the system returns 
matches within a six-year range (+/- 3 years of the age/DOB entered) toward the 
top of the Person Search List. 

 

Searching by Address: 
Phonetic Address Search vs. Exact Search 

In addition to Phonetic Name and Exact searches, CONNECTIONS provides the ability to 
search for records based on the search criteria entered in the address fields. Address searches 
can be either phonetic or exact. 

Since Exact search returns only records that match the search criteria character for character 
and space for space, it is not advisable to use the Exact search type when conducting an 
address search. 

In a Phonetic Address search, CONNECTIONS creates a pool of candidates (search results) 
by comparing the phonetic similarity of the search criteria entered in the Street 1 field with 
the information in the Street 1 field of an address recorded in the database. All other address 
search criteria (e.g., City) are used to score the candidates. The closer the Street 1 candidate 
information is to the Street 1 search criteria, the higher the candidate’s score will be. The 
table on the next page demonstrates the difference between scoring and filtering search 
results. 
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To use Phonetic Address search effectively, employ the “less is more” approach: enter only 
the street name in the Street 1 field, without a house number or suffix (e.g., “Avenue”). 

Search Results: 
Scoring vs. Filtering 

Result Description Search 
Type(s) 

Scoring Phonetic searches are 
“scored” by any and all 
additional search criteria 
that are entered. Scoring 
ranks candidates in the 
pool of results depending 
on how close they are to 
the search criteria. 

Phonetic 
Name 

Phonetic 
Address 
(see tip box at 
right) 

Filtering Exact searches are 
“filtered” by any and all 
additional search criteria 
entered. Filtering 
eliminates candidates 
from the pool of results. 

Exact 

Phonetic 
Address 
(see tip box at 
right) 

 

Other address fields can be used in conjunction with the 
Street 1 field to affect the ranking of the search results. For 
example, if you enter search criteria in the City field, 
addresses that match the Street 1 field and the City field 
receive a higher score in the search results than those that 
match the Street 1 field but do not match the City. 

If you include the number with the street name (e.g., “10 
Wilson”), all matches with that number and street name will 
return on the result list. In some instances, a number or street 
name that is phonetically similar to the search criteria will 
also return in the search results. 

The table on the next page provides examples of possible Phonetic Address search results. 

 

Phonetic Address searches may 
be scored and filtered, depending 

on the search criteria. 

Entering search criteria in additional 
address fields scores the search 

results. The closer a result is 
to all of the search criteria, 

the higher its score. 

Entering additional information in 
the Street 1 field filters the search 

results. For example, entering 
“Wilson” in the Street 1 field—

without a house number or suffix 
(e.g., “Avenue”)—returns all results 
with Wilson (or street names similar 

to Wilson) in the Street 1 field. 

In this example, addresses across 
New York State that match the 
Street 1 field return higher on 
the list of results. Addresses 

containing street numbers or a 
suffix (as well as street names that 
are phonetically similar to the street 

name in the search criteria) 
display lower on the list. 

It is advisable to conduct a 
Phonetic Address search using 
only the street name (without a 
house number or suffix) in the 
Street 1 field. This reduces the 

likelihood of filtering out 
a valid match. 
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A Phonetic Address search using the 
following criteria: 

Street 1 City 

Produces the following results: 

Wilson Apple City • Wilson, Apple City 

• Wilson, Beachville 

• Wilson, Chippertown 

• 5 Wilson, Apple City 

• 5 Wilson, Beachville 

• 63 Wilson, Beachville 

The results in this example would 
continue with all matches that are 
phonetically similar to the Street 1 
search criteria. 

5 Wilson Apple City • 5 Wilson, Apple City 

• 5 Wilson, Beachville 

• 5 Willston, Beachville 

• 5 Wilsound, Chippertown 

The results in this example would all 
have “5” in the Street 1 field. House 
number greatly influences the search 
results.  

 

A Phonetic Address search displays the following messages in the Person Search List title bar: 

• Phonetic Address Results Returned: All records in the database that sound similar 
to the address search criteria are returned in the Person Search List. 

• No Results Returned: No records in the database match the search criteria. 
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Conducting Person Searches 
Throughout your investigation, there will be occasions which require you to look up information 
about people associated with your assigned case. This includes all current and/or historical cases 
in which these individuals were involved. The following individuals need to be included in the 
Person List for an Investigation stage: 

• Subject(s), including Parent(s) and Guardian(s) of victim child(ren); and other person(s) 
18 years of age or older responsible for the victim child(ren)’s care at the relevant time 

• Abused/Maltreated Child(ren) 
• All other children living in the household 

 
Person Search is also helpful for finding staff persons when you do not know their agency code. 
By conducting a Person Search in this situation, you can obtain the Person ID for a staff person, 
then use the Person ID to conduct a Staff Search. You cannot obtain detailed information about a 
staff person in Person Search; use the staff person’s Person ID to conduct a Staff Search in order 
to retrieve detailed information. 
 

Conducting a Phonetic Name Search from the Toolbar 
You may need to conduct a Person Search from the CONNECTIONS Toolbar to determine if 
that person has a history in CONNECTIONS, in order to verify the information on the Intake/IRI 
Report and make sure you have all available information about a person. 

The Toolbar search method is not commonly used by CPS caseworkers, but in some 
circumstances it can be helpful. For example, if you receive a call from a reporter, source or 
other authorized person, you can use the Toolbar search method to determine the status or 
assignment of the case. 

The Relate function in CONNECTIONS links historical records concerning an individual to the 
current investigation. Keep in mind that the Relate function disables when you open the Person 
Search window from the CONNECTIONS Toolbar. 



 

CONNECTIONS Step-by-Step Guide: Page 25 
Search Techniques for CPS Caseworkers (rev 11/18/2003) 

 

 

Step-by-Step: 
Conducting a Phonetic Name Search from the CONNECTIONS Toolbar 

1 Click on the PERS button on the CONNECTIONS 
Toolbar. 
The Person Search window displays. 

2 Enter the person’s first and last name in the name fields. 

3 Enter the date of birth or approximate age, if known, in 
the DOB or Age fields. 

4 The Person Search window automatically defaults to 
Phonetic Name search. To choose a different type of 
search, click on the drop-down arrow for the Search 
Type field and select from the resulting list. 

5 Click on the Search button. 
CONNECTIONS performs a search based on your 
criteria and returns the results of your search in a list at 
the bottom of the Person Search window. Use the scroll 
bar to scroll down the list. 
 

Viewing Detailed Information About a Person 
Search results may include more than one possible match for 
your search criteria. Explore all possible matches. The 
individual you are searching for may be listed more than once 
in the database. Review the information in the Person Search 
List to determine if the person you are searching for matches one or more of the results on the 
list. If you don’t have enough information to make this determination, you can access more 
information about a person in the Person Search List by looking at case composition. This 
process is sometimes called “drilling down.” 

 

Step-by-Step: 
Viewing Detailed Information About a Person 

1 Click on a person’s name from the results in the Person Search List. 

2 Click on the Options menu and select Case List. 
The Case List window displays, containing a list of cases with which the selected 
individual is associated. 

3 Click on a case to select it. 

 

CONNECTIONS calculates the 
age from DOB information. If 

you don’t know the exact date of 
birth, enter an approximate age. 

CONNECTIONS identifies the 
type of date of birth with the 

following codes in the T column 
on the Person Search window, 

Person Search Output and 
Person List: 

• E (estimated) indicates a 
DOB converted from 
Legacy that has not been 
modified. These types are 
not considered when 
scoring candidates in a 
Person Search. 

• A (approximate) indicates 
an approximate DOB. 

• A blank column indicates an 
exact DOB. 
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4 Click on the Comp button. 
The Case Composition window displays with a list of the people associated with the 
selected case. Review this information (looking at the names of the people in the case, 
dates of birth and addresses) to determine if this is the same person as the one for whom 
you are searching. 

• If information in the Case Composition window led you to determine that this is the 
same individual as the one you are searching for, your search is complete. If the 
purpose of the search is to maintain case information, continue with the process of 
relating the individual to the stage. If there are multiple matches, relate the 
individual to the match with the most complete information and merge the remaining 
matches. Instructions on relating or merging persons can be found in the CPS Step-
by-Step Guide, Module 8, which is available on the CONNECTIONS Intranet site. 

• If information in the Case Composition window has led you to determine that this is 
not the same individual, choose another name from the search results and return to 
Step 1. If you do not find a match and the purpose of your search is to maintain case 
information, continue with the process of adding the individual to the stage. 
Instructions on adding an individual can be found in the CPS Step-by-Step Guide, 
Part 2, Module 2, which is available on the CONNECTIONS Intranet site. 

5 To close the Case Composition window, click on the Close button. 
The Case List displays. 

6 To close the Case List, click on the Close button. 
The Person Search window displays. 
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Conducting an Exact Search from the Toolbar 
When a Phonetic Name search does not return the name of the person for whom you are 
searching, you may need to narrow your search to find the person. One way to narrow a search is 
to conduct an Exact search. 

Keep in mind that Exact search considers search criteria character for character and space for 
space. If a person’s name was previously added to CONNECTIONS with a spelling different 
than the one you are using for your Exact search, the system will not return a match. Be careful 
not to define your search criteria too narrowly; a broad search generally returns a better pool of 
potential matches. Because Exact search is so limiting, it is always advisable to begin with 
Phonetic Name search. 
 

 

Step-by-Step: 
Conducting an Exact Search from the CONNECTIONS Toolbar 

1 Click on the PERS button on the CONNECTIONS Toolbar. 
The Person Search window displays. 

2 Enter one of the required search criteria (see page 18) into the appropriate field. Fields 
required to complete a particular type of search appear yellow when that type is selected 
from the Search Type drop-down list. Criteria that are not available for a particular type 
of search disable when that search type is selected. 

3 Click on the drop-down arrow for the Search Type field and select Exact. 

4 Click on the Search button. 

Continue with “Viewing Detailed Information About a Person” on page 25. 
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Conducting a Phonetic Name Search Within a Stage 
During the course of an investigation, you may identify an individual who should be added or 
related to the investigation. Before adding a person to a stage, CONNECTIONS guides you 
through a required Person Search to determine whether that individual has a history in 
CONNECTIONS. This functionality is intended to preserve data integrity by preventing the 
creation of duplicate records. 

Who can be added to a stage? 
Prior to adding anyone to a stage, it is necessary to establish if the individual is required by law 
(Social Services Law §412.4 and Family Court Act §1012.g) to be added to the stage (e.g., other 
persons named in the report, including non-culpable parents, guardians or other persons legally 
responsible and other children in the household). 

Before you add or relate an individual, you need to conduct a person search to see if the person is 
known to CONNECTIONS. When individuals are related in an Investigation stage, the 
“historical” person selected in the Person Search is added to the current Investigation stage. If 
the person is not known to CONNECTIONS, add the person as a new record. The Person Search 
is an important step because it helps prevent the creation of duplicate records. 

 

 

Step-by-Step: 
Conducting a Phonetic Name Search Within a Stage 

1 Click on the WORK button on the 
CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Click on a stage to select it. 
The Tasks… button enables. 

3 Click on the Tasks… button. 
The Task List displays for the selected stage. 

4 Click on the Maintain Person task. 

5 Click on the List… or New button. 
The Person List displays for the selected stage. 

6 Click on the New button. 
The Person Search window displays. 

 
Speak to your supervisor or 
check the CONNECTIONS 

System Build 14 Changes to 
Person Search Job Aid for tips 

on how to maximize your 
search results. 

This job aid is available in the 
Public Folders or on the 
CONNECTIONS Intranet 

Website. 
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7 The Person Search window automatically defaults to Phonetic Name search. The 
Search Type field contains a drop-down list of three person search options that 
indicate the type of search in effect: 

• Phonetic Name 
• Phonetic Address 
• Exact 

Fields that are required to conduct a particular type of search appear yellow when 
that search type is selected from the drop-down list. Criteria that are not available 
for a particular type of search disable when that search type is selected. 

8 Enter the person’s first and last name into the name fields. 

9 Enter the person’s date of birth or the approximate age, if known, into the DOB 
and/or Age fields.  

10 Click on the drop-down arrow for the Sex field and select from the resulting list. 

11 Click on the Search button. 
CONNECTIONS performs a search based on your criteria and returns the results 
of your search in a list at the bottom of the Person Search window. Use the 
vertical scroll bar to scroll down the list. 
 

Scoring sorts the search results and displays the matches most similar to the search criteria 
first, followed by less similar records. If you perform a Phonetic Name search, the scoring of 
every name in the candidate pool is based on the specific search name you entered. Although 
names phonetically further away from the search name will score lower, you will ultimately 
be able to see all possible matches. 

Additional criteria entered for a Phonetic Name search is scored, not filtered out. This 
ensures that potential matches are not eliminated from the pool of results. 

If you perform an Exact search, all records return which exactly match the search criteria. 
The ability to filter Exact search results by using other search criteria and the ability to 
validate the search address information using CODE-1 help users retrieve the best possible 
results. 

With the additional filters, any criteria entered (other than one of the required criteria) act to 
the selection criteria’s original pool (see page 18 for a list of required fields for Exact 
search). 

Continue with “Viewing Detailed Information About a Person” on page 25. 
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Conducting Address Searches 
There are times when you don’t have enough information to search for a person by name. For 
example, a reporter may not have known the name of the individuals in the report (also known as 
an “Unknown/Unknown”), or may have known only the individuals’ first names. 

Sometimes caseworkers have the names of the individuals in a report and the family composition 
seems familiar to them, but the address isn’t familiar. For example, the caseworker may 
previously have worked with a Hobbs family consisting of a mother named Tami and children 
named Regina and Derek. The caseworker thinks that a current report on the Assigned Workload 
involves the same family because the family composition is similar; but the address of the Hobbs 
family in the report isn’t the address of the Hobbs family the caseworker worked with before. 
The caseworker could search for the family by address to help determine if the two families are 
the same. 

 

Step-by-Step: 
Conducting a Phonetic Address Search 
from the CONNECTIONS Toolbar 

1 Click on the PERS button on the CONNECTIONS Toolbar. 
The Person Search window displays. 

2 Click on the drop-down arrow for the Search Type field and select Phonetic Address. 
The Street 1 field highlights in yellow, indicating that it is a required field for this type of 
search. 

3 Enter the street name, without a number or suffix, in the Street 1 field. 
To increase the effectiveness of your search, you can enter search criteria in additional 
address fields, such as City or ZIP Code. See page 22 for hints about conducting 
effective Phonetic Address searches. 

4 Click on the Search button. 
Search results display on the Person Search List in the lower half of the Person Search 
window. 

Continue with “Viewing Detailed Information About a Person” on page 25. 
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The Person Search List Output 
Some Person Searches may return a long list of results. You may find it useful to print the search 
results to help you keep track of your progress as you view detailed information about each 
person on the list. 

Other person searches may result in no matches being returned. You may consider it helpful to 
include a hard copy of the search results in the external case file as a record that a person search 
was conducted. 

The results of a Person Search can be printed by launching the Person Search List output. 
 

 

Step-by-Step: 
Generating the Person Search List Output 

1 After completing a Person Search, click on the Forms menu on the Person Search 
window and select Person Search List. 
The following message displays: 
“Please wait while form or document is being produced...” 
The Person Search List output then displays as a Microsoft Word document. 

2 To print the Person Search List output, click on the File menu and select Print. 
The Microsoft Word Print dialog box displays. Verify that the prompted printer choice 
is correct. 

3 Click on the OK button. 
The document prints to the selected printer. 

4 To close the report, click on the File menu and select Close. 
The report closes and the Person Search window displays. 
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Module 2: 
Case Search 

When working on an investigation, it is important to know about any other stages that may exist 
in the case, as well as other cases with which an individual may be involved. Historical cases are 
not always associated with the current case at the time of Intake, 
so historical cases may not appear on the Intake/IRI Report. 
Performing a Case Search enables you to retrieve historical 
information about case involvement for the individuals you are 
currently investigating. 

A Case Search is a direct route to case information when you 
know the Case ID number, Stage ID number or Case Name. 
When searching by Case Name, the search criteria must exactly 
match the CONNECTIONS Case Name in order for the search 
to return a match. Other names in the Case Composition for that case will not return. (For 
example, if a case is named after Sandra Connors, her daughter Mary will be included in the 
Case Composition, but will not return a match if the Case Search uses Mary’s name as the search 
criteria.) 

The Case List provides access to the Case Composition window, the Case Summary window and 
the Event List for the case. If the case you are viewing is outside your district (and you have no 
implied role) you are only able to view the Case Composition window and the Case Summary 
window. Historical Secondary workers (caseworkers who were assigned as Secondary workers 
at the time a stage was closed) are able to access the Case Composition window, the Case 
Summary window and the Event List for an entire case from the closed stage. This also applies to 
users having the “View All in District” security attribute from the same district as the Historical 
Secondary worker. The Primary worker’s name is listed in the Primary column of the Case List. 

Case List 

When a Case Search is conducted, the search results display on the Case List. This window 
contains the following columns: 

! An exclamation point (!) in this column indicates that the case is 
marked “sensitive.” 

Image A red check mark in this column indicates that one or more stages in 
the case pre-date the implementation of the CONNECTIONS system; 
the pre-dated information (as a scanned image) is available 
exclusively to the SCR. 

Mrg An M in this column indicates that the case was involved in a Case 
Merge. An S indicates that the case was involved in a Case Split. 

Status “CLD” in this column indicates that the case is closed. Open cases 
are designated with “OPN” in this column. 

 

The Case ID number 
can be found on the 
Intake/IRI Report. 
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Case Name This column contains the name of the case; typically, cases are 
named after the biological mother of the abused or maltreated child. 

Case ID This column contains the unique, eight-digit, system-generated case 
identification number. 

District/Agency This column lists the name of the local district that has Primary 
jurisdiction for the case. 

Zone This column, which is only be populated for cases in which the 
Primary address is in New York City, indicates the geographical 
borough subdivision corresponding to the case address. 

Case Type This column displays SVC for all CPS Intake and Investigation 
stages, as well as for Family Services Intake and Family Services 
Stages (including Child Case Record), which will be implemented 
with Build 18. Foster and adoptive home stages are designated with 
FAD in this column. 

Primary This column lists the name of the Primary worker for SVC cases and 
local district-authorized FAD cases; for voluntary agency-authorized 
FAD cases, the name of the agency displays in this column. 

 

Conducting Case Searches 
All Case Searches are conducted from the Case Search Criteria window, which is opened via the 
CASE button on the CONNECTIONS Toolbar. 
 

Conducting a Case Search by Case ID or Stage ID Number 
The Case ID and Stage ID numbers are unique, system-generated, 8-digit identification numbers. 
Using either the Case ID or Stage ID in the search criteria is a direct method for conducting a 
Case Search (if you have the correct 8-digit Case ID or Stage ID number), since only one case 
will display in the search results on the Case List. 

Entering a Case ID disables all other search fields in the Case Search Criteria window. Entering 
a Stage ID disables all other search fields in the Case Search Criteria window. The Case List 
window displays the case that contains the Case ID or Stage ID entered in the search criteria. 

 

Step-by-Step: 
Conducting a Case Search by Case ID or Stage ID Number 

1 Click on the CASE button in the CONNECTIONS Toolbar. 
The Case Search Criteria window displays. 

2 Enter the 8-digit Case ID number into the Case ID field (or the 8-digit Stage ID 
number in the Stage ID field). 
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3 Click on the Search button. 
The Case List displays with one case which matches the search criteria. 

To view detailed information about a case, see page 34. 

 

Conducting a Case Search by Case Name 
You can also conduct a Case Search using the Case Name in the search criteria. When 
conducting a Case Search by the Case Name, remember that this is the name of the case, not just 
the name of any individual associated with the case. Most CPS familial cases use the mother’s 
name for the Case Name. 

 

Step-by-Step: 
Conducting a Case Search by Case Name 

1 Click on the CASE button on the CONNECTIONS Toolbar. 
The Case Search Criteria window displays. 

2 Enter the first and last name of the case in the fields of 
the Case Name Search section on the Case Search 
Criteria window. 

3 To narrow your results to a specific county, click on the 
drop-down arrow for the County field and select from 
the resulting list. (Keep in mind that narrowing your 
search limits the results, which may miss the case you 
are searching for; always start with a name-only Case 
Search). 

4 Click on the Search button. 
The Case List displays, containing a list of cases which 
match the search criteria. 

To view detailed information about a case, see page 34. 

 

Viewing Detailed Information About a Case 
Once you have conducted a Case Search, you may need to view more detailed information about 
the case. The Case Summary window, Case Composition window and Event List provide 
detailed, case-specific information. These windows are accessed from the Case List. 

Your individual security profile and your role in the case determine the extent of your access to 
case information. If the case you are viewing is outside your district (and you have no implied 
role) you are only able to view the Case Composition window and the Case Summary window. 

 
The Zone field and the City field 

can also be used to further 
narrow a Case Search. The 

Zone field (which acts to filter 
the search results) enables only 
after selecting a County in the 

search criteria. 

The Zone field displays a code 
for NYC cases only. 
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Case Summary 
The Case Summary window lists all of the stages in a specific case and provides a brief overview 
of case information, including the status of the case (open or closed). You can view specific 
information about a person or a case by selecting a stage and clicking on the Options menu. The 
Allegation List, Person List and Case To-Do List are examples of the windows that can be 
opened from the Options menu. 

 

Step-by-Step: 
Viewing Detailed Information About a Case: 
Case Summary Window 

1 Click on a case from the Case List to select it. 

2 Click on the Summary button. 
The Case Summary window displays with a list of all stages in the selected case. A check 
mark in the SEC column on the Call Summary window indicates that a secondary 
assignment has been made to the stage. If the case being displayed is closed, the check 
mark indicates the existence of an Historical Secondary worker. You can access both 
person- and case-specific information from here by selecting a stage and clicking on the 
Options menu, then selecting an enabled command to navigate to related windows. 
 
The Case Summary window also includes a column labeled CD. As part of the 
implementation of a future build, this column displays the Community District for New 
York City stages. 

3 To close the Case Summary window, click on the Close button. 
The Case List displays. 

Case Composition 
The Case Composition window lists all of the individuals associated with any stage in the case 
and displays the relationship between these individuals. (This differs from the Person List, which 
contains information on all individuals associated with a particular stage of a case.) This window 
is useful in determining if the person you are searching for is the same person on the Search 
Results List (on the Person Search window), because it places the searched-for person in context 
of other household members. Evaluate the case composition to determine if it is relevant to your 
current investigation. 

 

Step-by-Step: 
Viewing Detailed Information About a Case: 
Case Composition Window 

1 Click on a case to select it from the Case List. 



 

Page 36 CONNECTIONS Step-by-Step Guide: 
(rev 11/18/2003) Search Techniques for CPS Caseworkers 

2 Click on the Comp button. 
The Case Composition window displays.  

3 To close the Case Composition window, click on the Close button. 
The Case List displays 

Event List 
The Event List for a case provides an historical list of significant case activities, including 
current and historical caseworkers assigned to the stages of a case, the date(s) when necessary 
letters were generated and the date on which certain tasks were approved. This information can 
help you obtain a comprehensive view of safety assessments and investigation conclusions for an 
historical case involving individuals who are associated with your current investigation. 

There are two types of Event Lists in CONNECTIONS: one contains a listing of events for a 
particular case; the other lists the events for a particular stage within a case. The Events button 
at the bottom of the Case List opens the Event List for the selected case. 

 

Step-by-Step: 
Viewing Detailed Information About a Case: 
Event List 

1 Click on a case from the Case List, then click on the Events button. 
The Event List displays for the case. 

2 To close the Event List, click on the Close button. 
The Case List displays. If you return to the Event List after viewing other windows, the 
Event List displays the previous scroll position and the previously selected event remains 
highlighted. 
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Module 3: 
Resource Search 

In the course of your casework, you may need to locate information on agencies, facilities or 
providers to arrange services for an individual associated with a case. If you know the name of 
the resource, you can conduct a Resource Search using the resource’s name in the search criteria. 
If you are looking for a resource that matches certain service and/or location characteristics, you 
can conduct a Resource Search using the resource’s characteristics in the search criteria. For 
example, if an individual who is associated with your investigation needs foster care, you can 
locate information regarding foster homes for your local district by conducting a search in the 
Resource Directory. 

The Resource Directory is considered the “yellow pages” of CONNECTIONS. It contains 
information about providers of child welfare-related services throughout New York State. 

Each resource has a designated Resource Type. Six Resource Types exist in the Resource 
Directory:  

Agency A local district (LDSS) or a voluntary agency. 

Only OCFS can enter and maintain agencies in CONNECTIONS. 
Each agency has a three-character agency code and 
CONNECTIONS-assigned Resource Identification (RID) number. 
The voluntary child caring agencies have been assigned Vendor 
Identification (VID) numbers. Voluntary agencies that operate 
facilities or certify/approve foster homes are displayed as Primary. 
They are able to submit Database Checks to the SCR. 

Facility A location that provides professional child welfare services: 
• Foster and Adoptive homes 
• OCFS congregate care facilities, such as institutions and 

group homes 
• OCFS, OMH and OMRDD facilities 
• OCFS preventive facilities (converted and new entered 

by districts) 

An organization or individual that provides services for the local 
district: 

• Day care • Foster care 
• Housing (preventive) • Adoption 

Provider 

Each Provider is maintained exclusively in CONNECTIONS by the 
district displayed as the Maintainer for that provider. 
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Hotline/Helpline  

Law Enforcement 

The Hotline/Helpline and Law Enforcement Resource Types are 
maintained by local districts. They are functional, but may not 
always be consistently maintained in every local district. 

School The School Resource Type is maintained by the state and includes 
public schools. 

 
As a CPS caseworker, the resources you generally will be searching for Facilities, Agencies or 
Providers. 

When searching for a resource, you must select the appropriate Resource Type to enable a 
search. For example, if you search for an Agency named “Baker Hall,” but you select “Law 
Enforcement” as the Resource Type, CONNECTIONS will return no results. 
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Searching for a Resource by Name 
When you need to find information for a resource and you know its name, it is more effective to 
conduct a Resource Search using the resource’s name in the search criteria. Resource Searches 
locate names alphabetically within the list of resources. For example, if you are conducting an 
agency search for Urban League, and you enter “Urb” in the Resource Name field, the results of 
the search include every agency on the Resource List that begins with “Urb.” Entering the first 
few letters of the resource name provides more results than entering the entire name of the 
resource. If you enter “Urban” in the same example, the results of the search include every 
agency on the Resource List that begins with “Urban.” 
 

 

Step-by-Step: 
Searching for a Resource by Name 

1 Click on the RSRC button on the CONNECTIONS Toolbar. 
The Resource Search Criteria window displays. The default Search Type is Phonetic 
Name. 

2 Enter the first few letters of the name of the resource you 
are searching for in the Resource Name field. 
The Search… button enables. 

3 Click on the Search… button. 
The Resource List displays with the results of your 
search. Use the horizontal and vertical scroll bars to see 
information beyond what is displayed on screen at one 
time. 

Continue with “Viewing Detailed Information About a Resource” on page 41. 

 

 

Step-by-Step: 
Searching for a Resource by Address 

1 Click on the RSRC button on the CONNECTIONS Toolbar. 
The Resource Search Criteria window displays. 

2 Click on the drop-down arrow for the Search Type field and select Phonetic Address. 
The Address 1 field highlights in yellow, indicating that it is a required field for this 
search type. 

3 Enter search criteria in the Address 1 field. 
For detailed information about using Phonetic Address search, see “Phonetic Address 
Search” on page 21. 

 
Omit punctuation when 

searching for a resource. Most 
resource names are spelled 

without punctuation in 
CONNECTIONS. 
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4 Click on the Search… button. 
If there are any resources in CONNECTIONS that match the search criteria, the 
Resource List displays with those results. If no resources match the search criteria, the 
following message displays: “No matches were found for these search parameters.” 
Click on the OK button to close the message box. 

Continue with “Viewing Detailed Information About a Resource” on page 41. 
 

Searching for a Resource by Characteristics 
When you need to locate an agency, facility or provider in order to arrange services for a person 
associated with one of your cases, you may find it more helpful to conduct a Resource Search by 
using the desired resource characteristics in the search criteria. For example, if you want to 
locate a facility that offers therapeutic foster care for adolescents, you can use these criteria for 
your search. You can also narrow your search by specifying a geographical area. 

When using resource characteristics as search criteria, the fields that enable in the Resource 
Search Criteria window are dependent upon which Resource Type is selected. 
 

 

Step-by-Step: 
Searching for a Resource by Characteristics 

1 Click on the RSRC button on the CONNECTIONS Toolbar. 
The Resource Search Criteria window displays. 

2 Click on the Search Type field and select 
Exact/Directory. 

3 Click on the drop-down arrow for the Resource Type 
field and select from the resulting list. 

4 Click on the drop-down arrow for the field which 
contains the characteristic you want to use in your search 
criteria, then select from the resulting list. 
(For example, if you are searching for a Facility, the 
Facility Type/LOC field enables; select from the Facility 
Types available in the drop-down list.) 

5 As you make selections from a field, other fields may enable; continue selecting from 
each enabled field’s drop-down list until the Search… button enables. 
At this point, you do not need to enter any other search criteria, but you can narrow your 
search by entering more criteria. 

6 Click on the Search button. 
The Resource List displays with the results of your search. Use the horizontal and 
vertical scroll bars to see information beyond what is displayed on screen at one time. 

 
For a list of all Agencies, select 

“Agency” in the Resource 
Type, Category and Service 

fields. 
To list by county, select a 

county in the County field and 
select the Location check box. 

Leave the name fields blank 
and click on the Search button. 
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Continue with “Viewing Detailed Information About a Resource” on page 41. 

 

Viewing Detailed Information About a Resource 
When CONNECTIONS performs a Resource Search results display in the Resource List. The 
Resource List provides summarized information about a resource, including its status, Facility 
Type/Level of Care (LOC), Resource ID number, Vendor ID (VID) number and authorizing 
agency. 

You can select a resource from the Resource List and view 
detailed information, including the Service Area, Comments and 
Update Information, by opening the Resource Detail window. 

 

Step-by-Step: 
Viewing Detailed Information 
About a Resource 

1 Click on a resource from the Resource List to select it. 

2 Click on the Detail... button. 
The Resource Detail window displays for the selected 
source. You can view a variety of information about the 
resource by clicking on the Address…, Phone…, 
Facility…, Svc Area… and Comments… buttons. 

3 To close the Resource Detail window, click on the 
Cancel button. 
The Resource List displays. 

4 To close the Resource List, click on the 
Close button. 
The Resource Search Criteria window displays. 

5 To close the Resource Search Criteria window, click on 
the Close button. 

 

 

 In the Resource Detail 
 window of an Agency’s listing, 
 you can generate a report of 
 all facilities in the agency. 

1. Click on the Options menu 
and select Resource 
Relationships. 
The Report Relationships 
window displays. 

2. Click on the Report menu in 
the Report Relationships 
window and select 
Facilities by 
Agency/District. 
The following message 
displays: “The report has 
been launched. Check 
Report List Window.” 

3. Click on the OK button. 

4. Click on the RPRTS button 
at the far right side of the 
CONNECTIONS Toolbar 
and select the report to be 
viewed and/or printed from 
the Report List. 
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Information on the Resource List 
 

Resource Name The name of the resource. 

VID The Vendor ID number. All resources must have a VID to receive 
payment via the Benefits Issuance Control System (BICS). 

Facility Type/LOC If the resource is a facility, the facility type or Level of Care 
(LOC) displays in this column; otherwise, the column is blank. 

Status The resource’s current status (Active or Inactive). 

Auth By The authorizing state agency (e.g., OMH, OMRDD, State 
Health), if required, that has authorized the resource. 

Maintainer The Agency ID/Jurisdiction—AST (OCFS staff), SDSS (local 
district staff), or voluntary agency—that has access to maintain 
the resource in CONNECTIONS. This field is “read only.” 

Street 1, City and 
County 

The resource’s street address, city and county. 

CD The Community District (NYC only). 

Phone and Ext The resource’s phone number and extension. 

Rsrc Type The resource type (e.g., Agency, Facility, Provider). 

Resource ID The resource’s unique system-generated identification number. 

Agency ID The 3-character identification code for the authorizing agency. 

Sub-Agency Displays for New York City resources only. 

FAD Facility If the facility is a Certified Foster Home, Certified 
Foster/Adoptive Home, or Approved Relative Foster Home, “Y” 
displays in this column; otherwise, this column will be blank. 

Last Update By The name of the worker who last updated the resource.  

Phone Number The phone number of the worker listed in the Last Update By 
column. 

Case ID Displays for FAD homes only. 

D/V Indicates whether the resource is a voluntary agency (V) or a 
local district (D). 

C Denotes whether Comments are recorded in the Resource Detail 
window. 
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Module 4: 
Staff Search and Office Search 

During the course of your investigation, you may occasionally need to contact staff persons in 
other units or districts/agencies, in order to obtain background information about the members of 
a household. You may also need to assign a To-Do to a staff person or make case assignments 
within your own unit or in another district. For example, if a Subject leaves the household during 
your investigation and that individual is now living in another county within New York State, 
you need to assign a Secondary worker in that other county (the “supportive district”). 

By using Staff Search and Office Search, CONNECTIONS users can obtain the contact 
information necessary to perform these tasks. If you are assigning a stage to a staff person in a 
unit outside your own, you might conduct a Staff Search to verify that the assignee is in the 
correct unit. 

Staff Search is the most effective method for finding contact information about a staff person. If 
you do not know the staff person’s name, but you know the agency, Office Search is the most 
effective method for locating contact information. 

Conducting a Staff Search 
All staff searches are conducted from the Staff Search Criteria window. This window is 
accessible from the CONNECTIONS Toolbar or from specific windows (e.g., Assign, To-Do 
Detail, Unit Summary). The manner in which you open the Staff Search Criteria window 
depends upon the purpose of your search: 

• To obtain contact information about a staff person, conduct a Staff Search from the 
CONNECTIONS Toolbar. 

• To search for a staff person in order to send a To-Do, search from within the To-Do 
Detail window. 

• To search for a staff person in order to assign/reassign a stage, search from within the 
Assign window. 
 

If you are unsure of the exact spelling of a staff person’s name, 
it is best to search on the first few letters of the last name. You 
must also include the Agency Code (or Type, Region and 
County) in the Office section of the Staff Search Criteria 
window. Staff Searches locate names alphabetically on the list 
of all staff for a specific agency. This is similar to looking up a 
name in a telephone book; your search criteria brings you to a 
specific point in the alphabetical listing of an agency’s staff. For 
example, a search for “Brown” returns staff members with last name Brown, and all other names 
that follow Brown on the list. If you conduct a Staff Search entering only a “B” in the Last 
Name field, the resulting list will contain the name of every staff person for that agency whose 
last name begins with the letter B. 

 

When searching for ACS staff, 
you must enter at least one 

letter in the Last Name field. 
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Person Search is also helpful for finding staff persons when you 
do not know their agency code. By conducting a Person Search 
in this situation, you can obtain the Person ID for a staff person, 
and then use the Person ID to conduct a Staff Search. You 
cannot obtain detailed information about a staff person in Person 
Search; use the staff person’s Person ID to conduct a Staff 
Search in order to retrieve detailed information. 

If you are searching for a staff person in a large agency (e.g., 
Erie County), you may find it helpful to use the Unit section of 
the Staff Search Criteria window. This can be particularly 
useful if you know the staff person’s unit but you are not sure of 
the spelling of the person’s name. 

When a Staff Search is complete, the Staff List displays in 
alphabetical order for the search criteria you entered. 
 

 

Step-by-Step: 
Conducting a Staff Search from the CONNECTIONS Toolbar 

1 Click on the STAFF button on the CONNECTIONS Toolbar. 
The Staff Search Criteria window displays. The Agency field defaults to your own agency 
code and the Active check box is selected. 

2 Enter search criteria. 
Enter the first few letters of the person’s last name. If you are searching for someone 
outside your agency and you know the agency code, enter it in the Agency field. If you do 
not know the staff person’s agency code, see the tip box above. 

3 Click on the Search button. 
The Staff List displays with the results of your search. 

 
If you want to search for a staff 

person and you do not know the 
agency information, conduct a 

Person Search first to obtain the 
Person ID number (see “Module 
1: Person Search”). The Person 

ID displays in the Person 
Search List. Write it down. Then 
conduct a Staff Search, using 
the Person ID field of the Staff 

Search Criteria window. Be sure 
to check the Additional 
Parameters check box. 
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Viewing Detailed Information About a Staff Person 
The Staff Detail window contains detailed information about a staff person, including contact 
information, supervisor’s name and whether the worker is case assignable. 

Staff persons do not have demographic information recorded in CONNECTIONS. 

 

Step-by-Step: 
Viewing Detailed Information About a Staff Person 

1 After conducting a Staff Search, click on a name to select it from the Staff List. 

2 Click on the Detail… button. 
The Staff Detail window displays. 

3 To close the Staff Detail window, click on the Cancel 
button. 
The Staff List displays. 

4 To close the Staff List, click on the Close button. 
The Staff Search Criteria window displays. 

5 To close the Staff Search Criteria window, click on the 
Close button. 

 
 

 
The Detail… button enables on 
the Staff List only when the list 

is accessed via the STAFF 
button on the CONNECTIONS 
Toolbar, not from the Assign 

window. 
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Conducting a Staff Search from the Assign Window 
When a decision is made to assign a stage to another staff person who is outside of your unit 
(e.g., for a cross-county assignment), you need to conduct a Staff Search from the Assign 
window to complete the assignment process. 

 

Step-by-Step: 
Conducting a Staff Search from the Assign Window 

1 Click on the WORK button on the CONNECTIONS Toolbar. 
The Assigned Workload displays. 

2 Click on a stage to select it. 

3 Click on the Assign… button. 
The Assign window displays. 

4 Click on the Options menu and select Staff Search Criteria. 
The Staff Search Criteria window displays. 

5 Enter the name of the staff person in the appropriate fields in the Person section; enter 
the Agency code if it is different from your own. 
If you do not know the staff person’s agency code, see the tip box under “Conducting 
a Staff Search from the CONNECTIONS Toolbar” on page 44. 

6 Click on the Search button. 
The Staff List displays the results of the search. 

7 Click on the staff person’s name to select it. 

8 Click on the OK button. 
The Assign window displays with the selected staff person included in the Available 
Staff list at the top of the window. 

 

Step-by-Step: 
Assigning a Stage After a Staff Search 

1 Select the staff person from the Available Staff list. 

2 Click on the Primary or Secondary button. 
If you choose Primary the following message displays: 
“This action will remove the current Primary worker from the stage. Continue?” 

◊ Clicking on the Yes button changes the Primary worker on the stage. The new 
Primary worker’s name displays on the Assignments list at the bottom of the 
window. 
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◊ Clicking on the No button cancels the pending assignment. No changes are 
made to the Assign window. 

◊ The Help button does not have functionality at this time. 
 If you choose Secondary, the selected worker appears on the Assignment list with a 

Secondary role. 

3 To save the assignment change and close the Assign window, click on the 
Save button. 

 

Conducting a Staff Search from the To-Do Detail Window 
If you need to send a To-Do to another staff person (e.g., a Reminder To-Do regarding an 
upcoming court date or a Task To-Do to enable the staff person to assist you with a case), you 
must conduct a Staff Search from the To-Do Detail window. This window can be accessed from 
a number of windows, including the Task List and the Assigned Workload. The following 
instructions open the To-Do Detail window from the Staff To-Do List: 

 

Step-by-Step: 
Conducting a Staff Search from the To-Do Detail Window 

1 Click on the TO-DO button on the CONNECTIONS Toolbar. 
The Staff To-Do List displays. 

2 Click on the New… button. 
The To-Do Detail window displays. 

3 Click on the Staff… button in the upper right corner of the To-Do Detail window. 
The Staff Search Criteria window displays. 

4 Conduct your search. 
For details about using the Staff Search Criteria window, see steps 2 and 3 of 
“Conducting a Staff Search from the CONNECTIONS Toolbar” on page 44. 

5 To exit the Staff Search Criteria window, click on the Close button. 
The To-Do Detail window displays. 

6 To save the To-Do, click on the Save button; to close the To-Do Detail window without 
saving, click on the Cancel button. 
The Staff To-Do List displays. 

7 To exit the Staff To-Do List, click on the Close button. 
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Using the Office Section of the Staff Search Criteria Window 
If you need to find a staff person within an office, but you are not sure of the name or spelling, 
use the Office section of the Staff Search Criteria window. The search results display a list of all 
staff persons in a specific office. For example, if you only know a staff person’s first name, you 
cannot use only that information in your search criteria; Staff Search requires the last name when 
searching by name, regardless of how much additional information is entered in the search 
criteria. By using the Office section of the Staff Search Criteria window, you can see the name 
of every staff person in the specified office; scroll down the list to find the person you are 
looking for. 

You can conduct this search from the Staff Search Criteria window, regardless of the manner 
you use to open this window; the instructions below open the window from the CONNECTIONS 
Toolbar. 

 

Step-by-Step: 
Searching for Staff via the Office Section 
of the Staff Search Criteria Window 

1 Click on the STAFF button on the CONNECTIONS Toolbar. 
The Staff Search Criteria window displays. The Agency field defaults to your own agency 
code and the Active check box is selected. 

2 Clear the default Agency Code in the Office section by highlighting the code and 
pressing the Delete key. 

3 Click on the drop-down arrow for the Type field and 
select from the resulting list (e.g., District, Vol Agen, 
Regional). 

4 Click on the drop-down arrow for the Region field and 
select from the resulting list (e.g., Syracuse, Rochester, 
NYC). 

5 Click on the drop-down arrow for the County field and 
select from the resulting list (e.g., Onondaga, Erie, 
Kings). 

6 Click on the Search button. 
The Staff List displays with results matching the search criteria. If no matches are found, 
the following message displays:  
“No staff match the entered search criteria. Please change the criteria.” 

7 Click on a staff person’s name in the Staff List. 
The Detail button enables. 

8 Click on the Detail button to view detailed information about the selected staff person. 
The Staff Detail window displays. 

9 To close the Staff Detail window, click on the Close button. 

 

Make sure your Region and 
County field selections are 
compatible. If the selected 

county is not in the selected 
region, the following 
message displays: 

“No staff match the entered 
search criteria. Please change 

the criteria.” 
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Office Search 
Office Search enables CONNECTIONS users to search for offices. For example, an Office 
Search for voluntary agencies by Region and County returns a list of all voluntary agencies 
within that region and county. You may find it helpful to have this information in a convenient 
location (e.g., if you wanted to have a list of OMH facilities within a specific region, or a list of 
voluntary agencies). 

All Office Searches are conducted from the Search menu on the CONNECTIONS Toolbar. 

When an Office Search is complete, the Office List displays in alphabetical order for the search 
criteria you entered. Further information can be viewed for an office by selecting it from the 
Office List and clicking on the Detail… button. 
 

 

Step-by-Step: 
Conducting an Office Search 

1 Click on the Search menu on the CONNECTIONS 
Toolbar and select Office… 
The Office Search Criteria window displays. 

2 Click on the menu for the Type field and select from the 
resulting list (e.g., State, Regional, District, Vol Agen). 

3 Click on the menu for the Region field and select from 
the resulting list (e.g., Syracuse, NYC, Yonkers). 

4 Click on the drop-down arrow for the County field and 
select a county or district within that region (e.g., 
Onondaga, Richmond, Westchester). 
If the selected county is not in the selected region, no results will return. 

5 Click on the Search button. 
The Office List displays results matching the search criteria. If no matches are found, the 
following message displays: 
“No match was found for the criteria specified in your search. 

6 To view detailed information (including staff) for an office on the Office List, click on the 
Detail… button. 
The Office Detail window displays for the selected office. 

7 To view staff detail, click on a staff person from the Office Assignment section of the 
Office Detail window and click on the Staff Dtl… button. 
The Staff Detail window displays for the selected staff person. 

 
The Type, Region and County 

fields required to enable an 
Office Search and are 

contingent upon the type 
selected. (Some Office Types 

disable the Region field.) 

Required fields are 
highlighted in yellow. 
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Conclusion 

Effective search techniques are a valuable skill for caseworkers as they use CONNECTIONS 
throughout the casework process. 

The information CONNECTIONS returns in a search is dependent upon the search method you 
use and the search criteria you enter. By using the appropriate search method and understanding 
how and when to broaden or narrow a search, you will improve the likelihood of finding the 
information you need. 

As a result of learning how to conduct effective searches in CONNECTIONS, you are better 
equipped to accomplish these tasks: 

• Determine whether an individual has a history in CONNECTIONS. 
• Locate historical case information. 
• Meet your clients’ needs by locating available resources. 
• Locate staff and offices in the CONNECTIONS system. 

 
Now that you recognize the importance of effective search techniques, you are better able to 
select the search method best suited to retrieve the information you need. 
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Appendix A: 
CONNECTIONS Logon Process Charts
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Chart A: 
Accessing CONNECTIONS Production 
(Windows NT 3.51) 
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Chart B: 
Accessing the Training Database/Preview Application 
(Windows NT 3.51) 
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Chart C: 
Accessing CONNECTIONS Production 
(Windows 2000) 
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Chart D: 
Accessing the Training Database/Preview Application 
(Windows 2000) 

 
 




